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1  Product features

Standard configuration features

Features may vary depending on the model. For support assistance and to learn more about the hardware
and software installed on your computer model, run the HP Support Assistant utility.

Ej?y NOTE: This computer model can be used in a tower orientation or a desktop orientation.

Standard configuration features 1



Front panel components

Drive configuration may vary by model.

Item Description Item Description

1 Optical drive (optional) 4 SD media card reader

2 Hard drive light 5 Microphone/headphone combo jack
3 USB ports (2) 6 Power button

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the computer and it is
displaying a diagnostic code. Refer to POST error messages and diagnostic front panel LEDs and audible codes on page 76 to interpret
the code.
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Rear panel components

o%
g.

i

Item Component Item Component

1 Q Line-in microphone connector (pink) 7 IOlCla  Serial port

2 =) Line-in audio connector (blue) 8 o~ USB ports

3 (C4 Line-out connector for powered audio devices 9 22 RJ-45 network connector
(green)

4 s HDMI port* 10 o<~ USB ports (4)

5 Security lock slot 11 Power cord connector

6 ] VGA monitor connector*

NOTE: When a graphics card is installed in one of the system board slots, the video connectors on the rear panel are covered.

The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components 3



2 lllustrated parts catalog

Computer major components

This chapter provides part information for all chassis.

Item Description

(1 Power supply, 180W

(2 Drive cage

(3) Power button board

@) Front bezel

(5) WLAN module (Intel Centrino Wireless-N 2230 WLAN WiFi 802.11 b/g/n + Bluetooth Half-Height Mini-PCl Express Card)
(6) Access panel

(7) System board (includes replacement thermal material)

(8) Computer chassis

9) Processors (include replacement thermal material)

Intel Core i7 8700 (3.2-GHz, 12-MB L3 cache), 65W

Intel Core i5 8500 (3.0-GHz, 9-MB L3 cache), 65W

Intel Core i5 8400 (2.8-GHz, 9-MB L3 cache), 65W

Intel Core i3 8011 (3.6-GHz, 6-MB L3 cache), 65W

Intel Pentium G5400 (3.7-GHz, 4-MB L3 cache), 65W

Intel Celeron G4900 (3.1-GHz, 2-MB L3 cache), 65W
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Item Description

(10) Fan duct
(11) Fan sink (includes replacement thermal material)
(12) Graphics cards

GeForce GT 730 graphics card, 2 GB

GeForce GT 730 graphics card, 1 GB

AMD Radeon R7 430, 2 GB

AMD Radeon R5 420, 1 GB (for use only in China)

Expansion card, parallel port, PCle x1

(13) Optical drive, 9.5 mm, slim tray
DVD-ROM
DVD+RW

(14) Hard drive, 3.5 inch

2 TB, 7200 rpm, 3.5 inch

17TB, 7200 rpm, 3.5inch

500 GB, 7200 rpm, 3.5 inch

(15) Memory modules (UDIMM, PC4-2666, 1.2V)

16-GB

8-GB

4-GB

x Solid-state drive (M.2)

256-GB, PCle

128-GB, PCle

128-GB, SATA-3, TLC

X Wireless antenna, single

*  notillustrated

Cables

Description

SATA data cable, optical drive

SATA data cable, hard drive

Hard drive + optical drive power cable

Power switch cable

Cables 5



Miscellaneous parts

Description

Optical drive bezel

Optical drive bezel blank (for use on models without an optical drive)

Optical drive latch

Antenna cover

Power cord

Keyboard

USB, slim

USB, Essential

USB, Katydid

HP, antimicrobial, slim (for use only in China)

Keyboard country codes

For use in country Spare part For use in country Spare part For use in country Spare part
or region number or region number or region number
Belgium -18x Internationally -L3x Russia -25x
BHCSY -B4x Israel -BBx Saudi Arabia -17x
Bulgaria -26x% Italy -06x South Korea -KDx
Canada (French) -12x Japan -29x Spain -07x
Czech Republic and -CGx Latin America -16x Sweden -10x
Slovakia

Denmark -08x Netherlands -DXx Switzerland -11x
France -05x Northwest Africa -DEx Taiwan -ABx
Germany -04x Norway -09x Thailand -28x
Greece -15x People’s Republic of China  -AAx Turkey -14x
Hungary -21x Portugal -13x United Kingdom -03x
India -D6x Romania -27x United States -00x

6 Chapter 2 Illlustrated parts catalog



Drives

Description

Hard drive, 3.5 inch

2TB, 7200 rpm, 3.5 inch

1TB, 7200 rpm, 3.5 inch

500 GB, 7200 rpm, 3.5 inch

Solid-state drive, M.2

256-GB, PCle

128-GB, PCle

128-GB, SATA-3, TLC

Optical drive

DVD+RW drive

DVD-ROM drive

Drives 7



3 Routine care, SATA drive guidelines, and
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system
board. You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities. A product can be degraded by 700 volts.

e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000V 35,000V
Walking across vinyl floor 3,000V 5,000V 12,000V
Motions of bench worker 400V 800V 6,000V
Removing DIPs from plastic tube 400V 700V 2,000V
Removing DIPs from vinyl tray 2,000V 4,000V 11,500V
Removing DIPs from Styrofoam 3,500V 5,000V 14,500V
Removing bubble pack from PCB 7,000V 20,000V 26,500V
Packing PCBs in foam-lined box 5,000V 11,000V 21,000V

8 Chapter 3 Routine care, SATA drive guidelines, and disassembly preparation



Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric
components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their containers.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm * 10% resistance in the ground cords.
To provide proper ground, a strap must be worn snugly against bare skin. The ground cord must be
connected to the banana plug connector on the grounding mat or workstation and fit snugly into it.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with
a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work area, observe the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the
work surface and use properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate. Handle
them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.
Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Electrostatic discharge information
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Recommended materials and equipment

The following grounding equipment is recommended to prevent electrostatic damage:
° Antistatic tape

e  Antistatic smocks, aprons, or sleeve protectors

e  Conductive bins and other assembly or soldering aids

e  Conductive foam

e  Conductive tabletop workstations with ground cords of one-megohm +/- 10% resistance
e  Static-dissipative table or floor mats with hard ties to ground

e  Field service kits

e  Static awareness labels

e  Wrist straps and footwear straps providing one-megohm +/- 10% resistance

e  Material handling packages

e  Conductive plastic bags

e  (Conductive plastic tubes

e  (Conductive tote boxes

e  Opaque shielding bags

e  Transparent metallized shielding bags

e  Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:
e  Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

e  Operate the computer on a sturdy, level surface. Leave a 10.2 cm (4-inch) clearance on all vented sides
of the computer and above the monitor to permit the required airflow.

e  Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

e  Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

e  Never operate the computer with the cover or side panel removed.

e Do not stack computers on top of each other or place computers so near each other that they are subject
to each other’s re-circulated or preheated air.

e If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be
provided on the enclosure, and the same operating guidelines listed above will still apply.

e  Keep liquids away from the computer and keyboard.

10 Chapter 3 Routine care, SATA drive guidelines, and disassembly preparation



Never cover the ventilation slots on the monitor with any type of material.

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions

1.
2.

3
4.
5
6

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use
the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

Follow all safety precautions in General cleaning safety precautions on page 11 before cleaning the computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping the surface
with a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed; alcohol will evaporate quickly
without leaving a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 11 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the computer
case on page 11.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 11
before following these procedures:

A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the

keys.

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too
much air pressure can dislodge lubricants applied under the wide keys.
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e [f youwant to remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronics supply outlets.

A CAUTION: Never remove a wide, level key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

e  (leaning under a key may be done with a swab moistened with isopropyl alcohol and then squeezed out.
Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a towelette designed for cleaning monitors or with a clean cloth
moistened with water. Do not use sprays or aerosols directly on the screen; the liquid may seep into the
housing and damage a component. Never use solvents or flammable liquids on the monitor.

e  To clean the monitor body follow the procedures in Cleaning the computer case on page 11.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  (lean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e  To clean the mouse body, follow the procedures in Cleaning the computer case on page 11.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software requirements

To service the computer, you need the following:

e  Torx T-15 screwdriver

e  Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
e  Phillips #2 screwdriver

° Diagnostics software

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP
strongly recommends that all screws removed during disassembly be kept with the part that was removed,
then returned to their proper locations.

A CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area
to prevent damage.
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Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts
being removed or replaced.

A CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies
to failed drives as well as replacement spares.

e If adrive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging
and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective
packaging until they are actually mounted in the computer.

e  Avoid dropping drives from any height onto any surface.

e Ifyouareinserting or removing a hard drive, turn off the computer. Do not remove a hard drive while the
computer is on or in standby mode.

e  Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

e Do not use excessive force when inserting a drive.
e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields

such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for
instructions on the replacement procedures.

A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or
expose it to temperatures higher than 140°F (602C). Do not attempt to recharge the battery.

[:;’/f’ NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste. In order to forward them for recycling or proper disposal, please use the public collection
system or return them to HP.
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SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 717

Number of pins in power cable 15

Maximum data cable length 39.37in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP personal computers have
built-in drive failure prediction that warns the user or network administrator of an impending failure (crash)
of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as
reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is
imminent, it generates a fault alert.

14  Chapter 3 Routine care, SATA drive guidelines, and disassembly preparation



4 Removal and replacement procedures

Adherence to the procedures and precautions described in this chapter is essential for proper service. After
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all
components operate properly.

[:?’/r NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly

A WARNING! Voltage is always present on the system board when the computer is plugged into an active AC
outlet. To avoid possible personal injury and damage to the equipment the power cord should be
disconnected from the computer and/or the AC outlet before opening the computer.

See Routine care, SATA drive quidelines, and disassembly preparation on page 8 for initial safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer.

2 Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.  Turn off the computer properly through the operating system, then turn off any external devices.
q

Disconnect the power cord from the power outlet and disconnect any external devices.

A CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing a
unit.

[:?’”r NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the removed components.
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Access panel

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

2. Loosen the captive Phillips screw (1), slide the access panel toward the back of the computer, and then
lift it off (2).

To install the access panel, reverse the removal procedure.
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Expansion card

Description

Graphics cards

GeForce GT 730 graphics card, 2 GB

GeForce GT 730 graphics card, 1 GB

AMD Radeon R7 430, 2 GB

AMD Radeon R5 420, 1 GB (for use only in China)

Expansion card, parallel port, PCle x1

The computer has one PCl Express x1 expansion socket and one PCl Express x16 expansion socket.

I% NOTE: You caninstall a PCl Express X1, x4, X8, or Xx16 expansion card in the PCl Express x16 socket.

For dual graphics card configurations, the first (primary) card must be installed in the PCl Express x16 socket.

To remove, replace, or add an expansion card:

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

2. Remove the access panel (Access panel on page 16).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion slot
on the back of the computer chassis.

4. Remove the two Torx screws (1) from the expansion card release latch, and then rotate the latch
downward to the open position (2).

PR

5. Beforeinstalling an expansion card, remove the expansion slot cover or the existing expansion card.

@7 NOTE: Before removing an installed expansion card, disconnect any cables that may be attached to
the expansion card.

a. Ifyouareinstalling an expansion card in a vacant PCl Express x16 socket, remove the appropriate
expansion slot cover on the back of the chassis. Pull the slot cover straight up then away from the
inside of the chassis.
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b. If you areinstalling an expansion card in a vacant PCl Express x1 socket, insert a flatblade
screwdriver into the slots on the rear of expansion slot cover (1) and rock the slot cover back and
forth to break it free from the chassis (2).
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6.
7.

¢. If youare removing a PCl Express x1 card, hold the card at each end, and carefully rock it back and
forth until the connectors pull free from the socket. Pull the expansion card straight up from the
socket.

d. If you are removing a PCl Express x16 card, pull the retention arm on the back of the expansion
socket away from the card (1) and carefully rock the card back and forth until the connectors pull
free from the socket. Pull the expansion card straight up from the socket (2).

Store the removed card in anti-static packaging.

If you are not installing a new expansion card, install an expansion slot cover to close the open slot.

A CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot
cover for proper cooling of internal components during operation.

Expansion card
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8. Toinstall a new expansion card, hold the card just above the expansion socket on the system board then
move the card toward the rear of the chassis (1) so that the bracket on the card is aligned with the open
slot on the rear of the chassis. Press the card straight down into the expansion socket on the system
board (2).

@7 NOTE: When installing an expansion card, press firmly on the card so that the whole connector seats
properly in the expansion card socket.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system board, if
needed.

11. Reconfigure the computer, if necessary.
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Front bezel

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

2. Remove the access panel (Access panel on page 16).

3. Pull the four tabs upward (1), and then rotate the bezel off the computer (2).

@" IMPORTANT: A cable connects the power button in the bezel to the system board.

To install the front bezel, reverse the removal procedure.

Front bezel
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Power button board

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

2. Remove the access panel (Access panel on page 16).

3. Remove the front bezel (Front bezel on page 21).

4. Position the front bezel with the inside toward you.
5. Remove the two Phillips screws (1) that secure the board to the inside of the front bezel.

6. Remove the power button board from the front bezel (2).

To install the power button board, reverse the removal procedures.
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Drives

Hard drives, 3.5 inch

2TB, 7200 rpm

17TB, 7200 rpm

500 GB, 7200 rpmh

Optical drive

DVD+RW drive

DVD-ROM drive

When installing drives, follow these guidelines:

e  The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA connector on
the system board labeled SATAO.

e  Connect an optical drive to the white SATA connector on the system board labeled SATA1.

A CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer, and
unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as
monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label the
package “Fragile: Handle With Care.”

Optical drive

The optical drive is located in the drive cage. You can remove the optical drive without removing the front
bezel or the drive cage.

A CAUTION: All removable media should be taken out of a drive before removing the drive from the computer.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

2. Remove the access panel (Access panel on page 16).

3. Disconnect the power and data cables from the rear of the drive (1), and then press the green lever to
disengage the drive from the drive bay (2).

A CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid
damaging the cable.
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4. Slide the optical drive out of the front of the computer (3).

To install the optical drive, reverse the removal procedure.
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Hard drive

The hard drive is located in the drive cage, above the optical drive. You must remove the drive cage to remove
the hard drive. You must remove the optical drive to remove the drive cage.

[% NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the optical drive (Optical drive on page 23).

Disconnect the cables from the rear of the hard drive (1).
Remove the three Torx screws that secure the drive cage to the computer (2).

Slide the drive cage toward the front of the computer (3).

@ N o oum s W N

Lift the drive cage out of the computer (4).

9. Toremove a hard drive from the drive cage, remove the four screws that secure the drive to the drive
cage (1), and then slide the drive out of the cage (2).

To install a hard drive, reverse the removal procedures.
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WLAN module

The WLAN module is located under the drive cage.

1. Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the drive cage (Hard drive on page 25).

2
3
4. Remove the optical drive (Optical drive on page 23).
5
6. Disconnect the antenna cable from the module (1).
7

Remove the Phillips M2.0x3.0 screw (2), and then pull the module out of the socket (3).

To install the WLAN modaule, reverse the removal procedures.
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Solid-state drive module

The M.2 solid-state drive module is located under the drive cage.

Solid-state drives, M.2

256-GB, PCle

128-GB, PCle

128-GB, SATA-3

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the optical drive (Optical drive on page 23).

Remove the drive cage (Hard drive on page 25).

@ s W
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To install the solid-state drive module, reverse the removal procedures.

Solid-state drive module

Remove the Phillips M2.0x3.0 screw (1), and then pull the module out of the socket (2).

27



Memory

DIMMs

Description

16-GB

8-GB

4-GB

The computer comes with double data rate 4 synchronous dynamic random access memory (DDR4-SDRAM)
dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to two industry-standard DIMMs. These
memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum memory
support, you can populate the system board with up to 32-GB of memory configured in a high-performing
dual channel mode.

DDR4-SDRAM DIMMs

For proper system operation, the DIMMs must be:

e  industry-standard 288-pin

e unbuffered non-ECC PC4-21300 DDR4-2666 MHz-compliant
e  1.2volt DDR4-SDRAM DIMMs

The DIMMs must also:

e  support CAS latency 16 DDR4 2666 MHz (16-16-16 timing)
e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e  single-sided and double-sided DIMMs

e  DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not supported

[%9 NOTE: The system will not operate properly if you install unsupported DIMMs.

Populating DIMM sockets

There are two DIMM sockets on the system board, with one socket per channel. The sockets are labeled
DIMM1 and DIMM3. Socket DIMM1 operates in memory channel B. Socket DIMM3 operates in memory channel
A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending
on how the DIMMs are installed.

r.%f' NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior graphics

performance.
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e  The system will operate in single channel mode if the DIMM sockets are populated in one channel only.

e  The system will operate in a higher-performing dual channel mode if the memory capacity of the DIMM
in Channel A is equal to the memory capacity of the DIMM in Channel B.

e  The system will operate in flex mode if the memory capacity of the DIMM in Channel A is not equal to the
memory capacity of the DIMM in Channel B. In flex mode, the channel populated with the least amount
of memory describes the total amount of memory assigned to dual channel and the remainder is
assigned to single channel. If one channel will have more memory than the other, the larger amount
should be assigned to Channel A.

e Inany mode, the maximum operational speed is determined by the slowest DIMM in the system.

Removing and installing DIMMs

A CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to drain
before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to
the memory modules as long as the computer is plugged into an active AC outlet. Adding or removing
memory modules while voltage is present may cause irreparable damage to the memory modules or system
board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting from
having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before beginning
these procedures, ensure that you are discharged of static electricity by briefly touching a grounded metal
object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the
module.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the drive cage (Hard drive on page 25).

2
3
4. Remove the optical drive (Optical drive on page 23).
5
6

To remove a memory module, open both latches of the memory module socket (1), and then remove the
memory module from the socket (2).

to
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7. Toinstall a memory module, open both latches of the memory module socket (1), and insert the
memory module into the socket (2).
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[% NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.

8. Push the module down into the socket, ensuring that the module is fully inserted and properly seated.
Make sure the latches are in the closed position (3).

The computer should automatically recognize the additional memory the next time you turn on the computer.
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RTC battery

The battery that comes with the computer provides power to the real-time clock. When replacing the battery,
use a battery equivalent to the battery originally installed in the computer. The computer comes with a 3-volt
lithium coin cell battery.

A WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.
Do not expose to temperatures higher than 60°C (140°F).
Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

A CAUTION: Beforereplacing the battery, it is important to back up the computer CMOS settings. When the
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

[1‘3? NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the drive cage (Hard drive on page 25).

2
3
4. Remove the optical drive (Optical drive on page 23).
5
6

Lift the battery out of its holder.

——

7. Slide the replacement battery into position, positive side up. The battery holder automatically secures
the battery in the proper position.

To install the RTC battery, reverse the removal procedures.
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Fan duct

The fan duct sits atop the fan sink and is secured to the fan sink with tabs.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

2
3. Remove the power supply cable from the clips on the duct (1).
4. Pull the tabs away from each other (2), and then lift the duct off the fan sink (3).

To install the fan duct, reverse the removal procedures.
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Fan sink

A CAUTION: The bond between the fan sink and the processor may be very tight.

If the computer will power on, before removing the fan sink, turn on the computer until it warms the fan sink.
Warming the fan sink lessens the bond between the heat sink and the processor, thereby making separating
them easier.

Make sure not to pull the processor out of the socket when you lift the fan sink, especially if you cannot warm
the fan sink prior to removal. Inadvertently removing the processor can damage the pins.

The fan sink is secured atop the processor with four captive Torx screws. The fan sink includes a heat sink and
a fan.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

2
3. Remove the fan duct (Fan duct on page 32).
q

Disconnect the fan cable from the system board (1), and then loosen the four captive Torx T15 screws
(2) that secure the fan sink to the system board tray.

A CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even the
downward forces on the processor. This is especially important as the pins on the socket are very fragile
and any damage to them may require replacing the system board.

5. Lift the heat sink from atop the processor (3).

To install the fan sink, reverse the removal procedure.

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and fresh
thermal grease has been applied to the top of the processor.

A CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to evenly
seat the fan sink on the processor to avoid damage that could require replacing the system board.

Make sure to replace the fan duct. Failure to install the fan duct may cause the computer to overheat.
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Processor

Description

Intel Core i7 8700 (3.2-GHz, 12-MB L3 cache), 65W

Intel Core i5 8500 (3.0-GHz, 9-MB L3 cache), 65W

Intel Core i5 8400 (2.8-GHz, 9-MB L3 cache), 65W

Intel Core i3 8011 (3.6-GHz, 6-MB L3 cache), 65W

Intel Pentium G5400 (3.7-GHz, 4-MB L3 cache), 65W

Intel Celeron G4900 (3.1-GHz, 2-MB L3 cache), 65W

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the fan duct (Fan duct on page 32).

Remove the fan sink (Fan sink on page 33).

Rotate the locking lever to its full open position (1).

Raise and rotate the microprocessor retainer to its fully open position (2).

N vuos W

Carefully lift the processor from the socket (3).

A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the
system board.

To install a processor, reverse the removal procedure.

@’ NOTE: Afterinstalling a new processor onto the system board, always update the system ROM to ensure
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the
Web at: http://www8.hp.com/us/en/support-drivers.html.
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Power supply

A WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP should be
used with the computer.

The power supply is located on the left side of the chassis. It is held in place by four Torx screws outside of the
chassis. The power cable routes under the drive cage.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the optical drive (Optical drive on page 23).

Remove the drive cage (Hard drive on page 25).

2
3
4. Remove the front bezel (Front bezel on page 21).
5
6

From the inside of the computer, disconnect the three power cables from the system board connectors
(1), (2), 3).

7. Onthe outside, rear of the computer, remove the four Torx T15 screws that secure the power supply to
the rear of the chassis (1).
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8. Ontheinside of the computer, press the power supply release button (2), and then lift the power supply
out of the computer (3).

To install the power supply, reverse the removal procedure.
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System board

1.

@ N o u s w N

10.
11.

Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the front bezel (Front bezel on page 21).

Remove the fan duct (Fan duct on page 32).

Remove the fan sink (Fan sink on page 33).

Remove the optical drive (Optical drive on page 23).

Remove the drive cage (Hard drive on page 25).

When replacing the system board, make sure the following components are removed from the defective

system board and installed on the replacement system board:

Memory modules (Memory on page 28)

WLAN module (WLAN module on page 26)

M.2 solid-state drive (Solid-state drive module on page 27)

Expansion cards (Expansion card on page 17)

Processor (Processor on page 34)

Disconnect the remaining cables from the system board, noting their locations for reconnection.

Remove the eight Torx screws (1) that secure the system board to the chassis.

Lift the front of the board up, and then pull it toward the front and out of computer (2).

To install the system board, reverse the removal procedure.

[%9 NOTE: When replacing the system board, you must also change the chassis serial number in the BIOS.

A CAUTION: When reconnecting the cables it is important that they be positioned correctly.

System board
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System board callouts
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Item  SysBd Label Component Item  SysBd Label Component
1 Xu1 Processor socket 10 BAT RTC battery
2 CFAN2 Fan sink 11 HDD1 Hard drive
3 ATX1 Power supply, 4 pin 12 0DD1 Optical drive
4 DIMM1 Memory module 13 ATX2 Power supply
5 DIMM2 Memory module 14 ATX1 Power supply, 7 pin
6 SSD Solid-state drive (M.2) 15 SATA_POWER  Drive power
7 PRB1 Power button 16 PCIEX1 Expansion card
8 WLAN1 WLAN (M.2) 17 PCIEX16 Expansion card
9 PSWD CMOS/password reset

SW_CMOS
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Antenna cable

The wireless antenna cable routes along the bottom of the computer chassis.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 15).

Remove the access panel (Access panel on page 16).

Remove the optical drive (Optical drive on page 23).

Remove the front bezel (Front bezel on page 21).

Remove the fan duct (Fan duct on page 32).

Remove the fan sink (Fan sink on page 33).

Remove the drive cage (Hard drive on page 25).

Remove the system board (System board on page 37).

S L L

Remove the cable from the three clips (1), (2), (3) built into base pan.

10. Peel the antenna off the front of the computer.

To install the antenna cable, reverse the removal procedures.
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5 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a
Full Boot. You can set the system to:

m  always Quick Boot (default);
m  periodically Full Boot (from every 1 to 30 days); or
m  always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-0n Self-Test (POST)
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1
through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.
Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

Secure integrated I/0 functionality, including the serial, USB, or parallel ports, audio, or embedded NIC,
so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Solve system configuration errors detected but not automatically fixed during the Power-0n Self-Test
(POST).

Replicate the system setup by saving system configuration information on a USB device and restoring it
on one or more computers.

Execute self-tests on a specified ATA hard drive (when supported by drive).

Enable or disable DriveLock security (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the
Computer Setup Utilities menu, complete the following steps:

1. Turnon or restart the computer.
2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

[%f NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. Achoice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power,
and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press
Esc.

5. To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e  Toreset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

['_ﬁ”f NOTE: Not all settings shown in the following sections are available for all models

A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup
screen.
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Computer Setup—rFile

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option Description

System Information Lists:
e Manufacturer
e Product name
e SKUnumber
e  Serial number
e  System family
e Bornondate
° System board CT number
° BIOS revision
° BIOS date
° Processor type
° Processor speed

e Installed memory size/speed, number of channels (single or dual) (if applicable)

About Displays copyright notice.

System Log Displays the system log.

Set Time and Date Allows you to set system time and date.
Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Exit Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit  Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

Ej?)y NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options may be
presented:

] Hard Disk: Size, model, firmware version, serial number, connector color.
—  M.2:Size, model,
—  SATA1: Size, model

e  CD-ROMr (not included for USB CD-ROM).

Storage Options

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system. There
are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or
corrupt established volumes.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver loaded in
the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of
more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/AHCI
volume. If you attempt to boot from a RAID/AHCI volume without the required device driver installed, the
system will crash (blue screen). RAID volumes may become corrupted if they are booted to after disabling
RAID.

Boot Order

Allows you to:

o  UEFIBoot Sources: Specify the order in which UEFI boot sources (such as a internal hard drive, USB
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

UEFI boot sources always have precedence over legacy boot sources.

e  Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable UEFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu)
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use
the arrow keys to select the preferred bootable device and press Enter. The computer then boots from the
selected non-default device for this one time.

Computer Setup (F10) Utilities
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Computer Setup—Security

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and
make changes to certain plug and play settings under Windows.

Power-0n Password Allows you to set and enable a power-on password. The power-on password prompt appears after a
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options Allows you to enable/disable:
(This selection appears ° Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change
only if a power-on resource settings for serial and parallel ports).

password or setup

password is set.) e  Stringent security (enabling the stringent password disables the ability to reset the password by

moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or the
power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

° Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10
Setup Options without entering setup password). Default is enabled.

° Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

° Network Server Mode. Default is disabled.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:
° System audio
NOTE: Set this value to ‘Device hidden’ to disable all system volume.
e  Network controller
NOTE: You must disable AMT before trying to hide the network controller.

e  SATA ports (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:
e  Rear USB Ports

° Internal USB Ports

Slot Security Allows you to disable any M.2 slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server.
Default is enabled.

System IDs Displays the following:
° Product name.

e  Serial number.
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e Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis serial
number is invalid. (These ID numbers are normally set in the factory and are used to uniquely
identify the system.)

° SKU number.
e  System family.
e  Feature byte.

e  BuildID.

Keyboard locale setting for System ID entry.

System Security (these
options are hardware
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default is
enabled.

TPM - A Trusted Platform Module (TPM) is a specialized chip on a computer that stores RSA encryption
keys specific to the host system for hardware authentication. Each TPM chip contains an RSA key pair
called the Endorsement Key (EK).

- TPM Device (available/hidden). Lets you set the Trusted Platform Module as available or hidden. Default
is available.

- TPM state (enable/disable) - Select to enable the TPM.

- Clear TPM (yes/no). Select to reset the TPM to an unowned state. After the TPMis cleared, it is also
turned off. To temporarily suspend TPM operations, turn the TPM off instead of clearing it.

IMPORTANT: Clearing the TPM resets it to factory defaults and turns it off. You will lose all created keys
and data protected by those keys.

Intel Software Guard Extensions (SGX) (enable/disable) - Intel SGX is a set of CPU instruction codes that
allows user-level code to allocate private regions of memory, called enclaves, that are protected from
processes running at higher privilege levels.

Virtuallization Technology (VTx/VTd) (enable/disable) — Enables the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is disabled.

Restore Security Settings to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will
erase all security keys and leave the device in a disabled state. Changing this setting requires that you
restart the computer. Default is Do not reset.

Secure Boot
Configuration

e  Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so on. If set
to disable, legacy boot options in Storage > Boot Order are not displayed. Default is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before
booting to it, making Windows resistant to malicious modification from preboot to full 0OS booting,
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by pre-
approved digital certificates to run during the firmware and 0S boot process. Default is disabled.
Secure Boot enabled also sets Legacy Support to disabled.

e  Key Management—This option lets you manage the custom key settings.

- Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom
boot keys. Default is Don't Clear.

- Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the
contents of the secure boot signature databases and the platform key (PK) that verifies kernels
during system start up, allowing you to use alternative operating systems. Selecting HP Keys
causes the computer boot using the preloaded HP-specific boot keys. Default is HP Keys.

e  Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys
to access items before the operating system loads. Default is disabled.

Computer Setup (F10) Utilities
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Computer Setup—Power

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Description

0S Power Management

° Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

° Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

Hardware Power
Management

SATA Power Management — Enables or disables SATA bus and/or device power management. Default is
enabled.

Thermal

CPU Fan Speed—-Display current fan speed.

Computer Setup—Advanced
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[%’ NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Heading

Power-0n Options

Allows you to set:

e  POST messages (enable/disable). Enabling this feature will cause the system to display POST error
messages, which are error messages displayed on the monitor during the Power On Self Test if the
BIOS encounters some kind of problem while starting the PC. A POST error message will only display
on screen if the computer is capable of booting this far. If the POST detects an error before this
point, a beep code is generated instead. Default is disabled.

e  After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
—  Power off—causes the computer to remain powered off when power is restored.
—  Power on—causes the computer to power on automatically as soon as power is restored.

- Previous state—causes the computer to power on automatically as soon as power is restored,
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to
use the suspend/sleep feature or the Remote Management features.

° POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process.
This delay is sometimes needed for hard disks on some PCl cards that spin up very slowly, so slowly
that they are not ready to boot by the time POST is finished. The POST delay also gives you more
time to select F10 to enter Computer (F10) Setup. Default is None.

e  Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Bus Options

Allows you to enable or disable:
° PCI SERR# Generation. Default is enabled.

° PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCl configuration space; only
needed when more than one graphics controller is installed. Default is disabled.

Device Options

Allows you to set:
e Num Lock State at Power-0n (off/on). Default is off.

e  Multi-Processor (enable/disable). Default is enabled.
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e  Hyper-Threading (enable/disable). Default is enabled.

e NIC PXE Option ROM Download (enable/disable). Default is enabled.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command with the
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 42 in the

Computer Setup—File table.)

Ej?)y NOTE: Itis recommended that you save any modified computer configuration settings to a USB flash media
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File

on page 42 in the Computer Setup—File table.)

Recovering the Configuration Settings

a7



Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard
drive, graphics, audio, memory, and software problems. If you encounter problems with the computer, refer
to the tables in this chapter for probable causes and recommended solutions.

[%/r NOTE: Forinformation on specific error messages that may appear on the screen during Power-0n Self-Test

(POST) at startup, refer to POST error messages and diagnostic front panel LEDs and audible codes
on page 76.

Safety and comfort

A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may

result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for
more information on choosing a workspace and creating a safe and comfortable work environment. For more
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
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If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact
problem before calling for technical support.

e  Runthe HP diagnostic tool.

e  Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 40 for
more information.

e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 76 for more information.

e If the screenis blank, plug the monitor into a different video port on the computer if one is available. Or,
replace the monitor with a monitor that you know is functioning properly.

e If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

e If yourecently added new hardware, remove the hardware and see if the computer functions properly.
e If yourecently installed new software, uninstall the software and see if the computer functions properly.

° Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting
the operating system, use “Last Known Configuration.”

e  Refer to the comprehensive online technical support at http://www.hp.com/support.

e  Refer to Helpful hints on page 49 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:

Be in front of your computer when you call.

Write down the computer serial number, product ID number, and monitor serial number before calling.
Spend time troubleshooting the problem with the service technician.

Remove any hardware that was recently added to your system.

Remove any software that was recently installed.

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

A CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before
running the restore process.

[:;’/f’ NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider
or dealer.

Helpful hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

Check that the computer and monitor are plugged into a working electrical outlet.

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

Check that the computer is turned on and the white power light is on.
Check that the monitor is turned on and the green monitor light is on.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 76 for more information.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
Check all cable connections for loose connections or incorrect connections.

Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for at
least four seconds then press the power button again to restart the computer. If the system will not shut
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart,
press the power button to start the computer.

Reconfigure the computer after installing a non-plug and play expansion board or other option. See
Solving Hardware Installation Problems on page 66 for instructions.

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that model printer.

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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e If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

e |f the system has multiple video sources (embedded, PCl, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be plugged into the monitor
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors
are disabled and if the monitor is connected into these ports, the monitor will not function. You can
select which source will be the default VGA source in Computer Setup.

A CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the

system board. You must disconnect the power cord from the power source before opening the computer to
prevent system board or component damage.

Solving general problems
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You may be able to easily resolve the general problems described in this section. If a problem persists and you
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an
authorized dealer or reseller.

A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system

board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing the ~ Before turning on the computer, press and hold F10. Turn on the
F10 access screen to display too briefly when booting the computer and continue to hold F10 until the Computer Setup
computer. (F10) Utility is displayed.

-or-—

Follow the Windows instructions for rebooting the computer into
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause

Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup
can also be used to update the RTC date and time). If the problem
persists, replace the RTC battery. See the Removal and
Replacement section for instructions on installing a new battery,
or contact an authorized dealer or reseller for RTC battery
replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly connected and
powered on and that the speakers' volume control is set
correctly.

3.  Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock . A
key to unlock the Smart Cover Lock is not available from HP. Keys
are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave a
10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2.  Make sure fans are connected and working properly (some
fans only operate when needed).

3.  Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.
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Poor performance.

Cause

Solution

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

1.

2.

Close unnecessary applications to free up memory.
Add more memory.

Some applications run in the background and can be closed
by right-clicking on their corresponding icons in the task
tray. To prevent these applications from launching at
startup:

In Windows 7:
a. Goto Start > All Programs > Accessories > Run
b. Typemsconfig, andthen press Enter.

¢.  Onthe Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

In Windows 10:

a. Typemsconfigin the taskbar search box, and then
select msconfig.

b.  On the Startup tab of the System Configuration Utility,
click Open Task Manager.

¢.  Select applications that you do not want to launch
automatically, and the click Disable.

Some software applications, especially games, are stressful on
the graphics subsystem.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution
Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and the
. processor cooling fan is running.
A fan may be blocked or not turning.
2. Openthe access panel, press the power button, and see if
OR the processor fan (or other system fan) spins. If the fan does
The heat sink is not properly attached to the processor. not spin, make sure the fan cable is plugged onto the system
board header.
3. Iffanaplugged in and not spinning, replace it.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:

1.

3.
OR

If equipped with a voltage selector, check that the voltage
selector (located on the rear of the power supply) is set to
the appropriate voltage. Proper voltage setting depends on
your region.

Remove the expansion cards one at a time until the 5V_aux
light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open the access panel and check that the power button
cable is properly connected to the system board.

Check that the power supply cables are properly connected
to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
assembly.

If the 5V_aux light on the system board is off, then replace
the power supply.

Replace the system board.
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Solving power problems

Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on Select the proper AC voltage using the selector switch.
rear of computer chassis (some models) not switched to correct
line voltage (115V or 230V).

Power supply will not turn on because of internal power supply Replace the power supply.
fault.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and the

processor cooling fan is running.
A fan may be blocked or not turning.

2. Openthe access panel, press the power button, and see if
OR the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the system

The heat sink is not properly attached to the processor.
board header.

3. If fan a plugged in and not spinning, replace it.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Computer powered off automatically and the Power LED flashes red three times and then white four times.

Cause Solution

Power failure (power supply is overloaded). 1.  If equipped with a voltage selector, check that the voltage
selector, located on the rear of the power supply (some
models), is set to the appropriate voltage. Proper voltage
setting depends on your region.

2. Open the access panel and ensure the power supply cable is
seated into the connector on the system board.

3.  Checkif a device is causing the problem by removing ALL
attached devices (such as hard drives or optical drives).
Power on the system. If the system enters POST, then power
off and replace one device at a time and repeat this
procedure until failure occurs. Replace the device that is
causing the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving hard drive problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. InWindows 7, click Start, click Computer, and right-click on
adrive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

In Windows 10, type £i 1e in the taskbar search box, and
then select File Explorer from the list of applications. In the
left column, expand This PC, right-click on a drive, select
Properties, and then select the Tools tab. Under Error
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with a

file.

In Windows 7, click Start, expand Computer, and right-click on a
drive. Select Properties, and then select the Tools tab. Under
Error-checking click Check Now.

In Windows 10, type f£ile in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly

installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 66 section. If the system still

does not recognize the new device, check to see if the device is
listed within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Boot Options.

The device is attached to a SATA port that has been hidden in

Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Advanced > Port Options.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Boot Options.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

A Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then select
the File Backup Program option, and then restore the
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry in
the Advanced > Boot Options list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Advanced > Boot
Options and ensure the bootable hard drive is listed immediately
under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Runthe Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Advanced > Port
Options.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if any
beeps are heard. See POST error messages and diagnostic front
panel LEDs and audible codes on page 76 to determine possible
causes for the blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

1. Use the task manager to close programs that do not
respond.

2.  Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to
turn off the power. To restart the computer, press the power
button again.
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Solving media card reader problems

Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity Either format the media card in the digital camera or select FAT
greater than 32MB with the FAT32 format. Some digital cameras file system to format the media card in a computer with Windows.
use the FAT (FAT16 & FAT12) format and can not operate with a

FAT32 formatted card.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature If using an SD card, make sure that the lock tab located on the
that prevents writing to and deleting from an SD/Memory right of the SD card is not in the locked position. If using a Memory
Stick/PRO card. Stick/PRO card, make sure that the lock tab located on the bottom

of the Memory Stick/PRO card is not in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card
to see if it writable. Refer to the previous section for a list of
compatible cards.

Media card is locked. Locking the media card is a safety feature If using an SD card, make sure that the lock tab located on the
that prevents writing to and deleting from an SD/Memory right of the SD card is not in the locked position. If using a Memory
Stick/PRO card. Stick/PRO card, make sure that the lock tab located on the bottom

of the Memory Stick/PRO card is not in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong Ensure that the card is inserted properly with the gold contact on
slot, or is not supported. the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card out
of the slot.

In Windows 10, type £i 1e in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on the corresponding drive
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing
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After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the

computer.

Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize the media
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

1.  If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems

If you encounter display problems, see the documentation that came with the monitor and to the common

causes and solutions listed in the following table.

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer and
to the electrical outlet.

You may have a screen blanking utility installed or energy saver
features are enabled.

Press any key or click the mouse button and type your password
(if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate
as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the
monitor.
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Blank screen (no video).

Cause Solution

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 10, type control
panel in the taskbar search box, and then select Control
Panel from the list of applications.

2. Expand the Resolution box, and then use the sliding control
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3.  Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2.  Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.
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Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor may
be incorrectly adjusted.

1. Besure the monitor cable is securely connected to the
computer.

2.  Inatwo-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with each
other’s electromagnetic field by moving them apart.

3.  Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came with
the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the 0SD menu. Select
ImageControl/ Horizontal Position or Vertical Position to adjust
the horizontal or vertical position of the image.
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“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what the

monitor supports.

Restart the computer and enter Safe Mode. Change the settings to
a supported setting then restart the computer so that the new
settings take effect.

To enter Safe Mode in Windows 7:
1. Restart the computer.

2. Press and hold the F8 key as your computer restarts, before
the Windows logo appears. If the Windows logo appears,
you must restart the computer and try again.

3. Onthe Advanced Boot Options screen, use the arrow keys to
highlight the safe mode option you want, and then press
Enter.

4. Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.

To enter Safe Mode in Windows 10:
1. Loginto the computer using an Administrator account.

2. Typemsconfig in the taskbar search box, and then select
msconfig from the list of applications.

3. Click the Boot tab, select Safe boot and then click OK.

High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the

graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen
display functions. To download a SoftPaq that will assist you
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

with the synchronization, go to the following Web site,
select the appropriate monitor, and download either
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models).

1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause

Solution

The font you are using does not support that particular symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map into a
document.

In Windows 7, click Start, select All Programs, select Accessories,
select System Tools, and then select Character Map.

In Windows 10, type ch in the taskbar search box, and then select
Character Map from the list of applications.

Solving audio problems

If the computer has audio features and you encounter audio problems, see the common causes and solutions

listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust the
volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Advanced > Built-in Device
Options.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle. The
speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently
installed sound card.

See the sound card documentation for proper speaker connection.
The rear audio jack output is the green receptacle.
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Sound does not come out of the speaker or headphones.

Cause

Solution

Headphones or devices connected to the line-out connector mute
the internal speaker.

Turn on and use headphones or external speakers, if connected,
or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select Advanced >
Built-in Device Options.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices and
is not designed for headphone use.

Plug the headphones into the headphone connector on the front
of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio filein a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack or
set the jack to its default value.
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There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems

If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-D0OS commands, press the Windows key + r, type cmd
in the Open box, and then click OK.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.
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Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it back
on.

Printer will not print.

Cause

Solution

The printer may be out of paper.

Solving keyboard and mouse problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no

function of mouse/keyboard and external drive.

Cause

Solution

If your computer is equipped with USB 3.0 ports, connected USB
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that
is separated from ports with USB 3.0 devices. If you still
experience interference, you may have to place the connectors
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back of
the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.
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Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Usethe arrow keys to select Shut Down and then press
Enter.

3.  After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Usethearrow keys to scroll to and select the power icon at
the top right on the menu, and then press Enter.

3.  Usethearrow keys to select Shut Down, and then press
Enter.

4.  After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the internal
components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make contact
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean
the internal components with a mouse cleaning kit available from
most computer stores.

Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or
expansion card. If you install a plug and play device, Windows automatically recognizes the device and
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the
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instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
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A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 6-1 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting the
changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings
for the board and choose a basic configuration that does not
cause a resource conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device available
is selected for appropriate USB ports under Advanced > Port
Options.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1.  Review the documentation that came with the system to
determine if you are using the correct memory modules and
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMMA4.

2.  Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3. Ifyoustill cannot resolve the issue, contact Customer
Support.

Solving Hardware Installation Problems
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Power LED flashes Red three times and then white two times.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board,
you must unplug the computer power cord before attempting to
reseat, install, or remove a DIMM module.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These guidelines
do not discuss the process of debugging the network cabling.

Table 6-2 Solving Network Problems

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2.  Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Incorrect network driver. Check the network controller documentation for the correct driver
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution
No active network is detected. Check cabling and network equipment for proper connection.
Network controller is not set up properly. Check for the device status within Windows, such as Device

Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.
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Table 6-2 Solving Network Problems (continued)
Network status link light never flashes.

NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2.  Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of
the cable.

Ensure that the cable and device at the other end are operating
correctly.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the Control Panel
and configure the network controller.

To access Control Panel in Windows 7, click Start, and then select
Control Panel.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel from the
list of applications.

Solving Network Problems
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Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 10.

If necessary, download the softpaq from the web (from a different
computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.

Cause

Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present, and
that the Remote System Installation Server contains the NIC
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.
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Solving memory problems

If you encounter memory problems, some common causes and solutions are listed in the following table.

A CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

&7 NOTE:

The memory count will be affected by configurations with the Management Engine (ME) enabled. The

ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to
download, decompress, and execute the ME firmware for Out-of-Band (00B), third-party data storage, and

other management functions.

System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1 socket.

Ensure that a memory module is installed in the DIMM1 or XMM1
socket on the system board. This socket must be populated with a
memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the
computer. On some models, ECC and non-ECC memory modules
cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly and
that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add more
memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps

stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving USB flash drive problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in Advanced
> Port Options.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Advanced > Boot Options. Ensure USB is enabled in
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.
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Solving front panel component problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is connected
to the device and one end is connected to a live outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. If possible, replace the cable.

2.  Restart the computer.

The device is not working.

1.  Replace the device.

2.  Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports are
set to Enabled in Security > USB Security.

Solving Internet access problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common

causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED light on
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to
bad weather.

Try connecting to the Internet at a later time or contact your ISP.
(If the cable/DSL service is connected, the “cable” LED light on the
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and the
computers’s RJ-45 connector. (If the connection is good, the “PC”
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information
that a Web server can store temporarily with the Web browser.
This is useful for having the browser remember some specific
information that the Web server can later retrieve.)

Windows 7:
1.  Select Start > Control Panel.

2.  Click Internet Options.

Solving front panel component problems
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Unable to connect to the Internet.

Cause

Solution

3.

In the Browsing history section on the General tab, click the
Delete button.

4. Select the Cookies check box and click the Delete button.
Windows 10:
1. Typecontrol panel inthe taskbar search box, and then
select Control Panel from the list of applications.
2.  Click Internet Options.
3. Inthe Browsing history section, click the Delete button.
4. Select the Cookies and website data check box and click the
Delete button.
Cannot automatically launch Internet programs.
Cause Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.
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Solving software problems

Most software problems occur as a result of the following:

e  The application was not installed or configured correctly.

e  Thereis insufficient memory available to run the application.

e  Thereis a conflict between applications.

° Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check to be

sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the computer.
See POST error messages and diagnostic front panel LEDs and
audible codes on page 76 to determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version of
Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.

Solving software problems
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7 POST error messages and diagnostic front
panel LEDs and audible codes

This appendix lists the error codes, error messages, and the various indicator light and audible sequences
that you may encounter during Power-0n Self-Test (POST) or computer restart, the probable source of the
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test.
Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

r.%’ NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 40.

POST numeric codes and text messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

[%9 NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action
002-0ption ROM Checksum Error System ROM or expansion board option ROM 1. Verify the correct ROM.
checksum.

2.  Flash the ROM if needed.

3. If an expansion board was recently added,
remove it to see if the problem remains.

4. Clear CMOS. (See Password security and
resetting CMOS on page 83.)

5. If the message disappears, there may be a
problem with the expansion card.

6. Replace the system board.

003-System Board Failure DMA or timers. 1.  Clear CMOS. (See Password security and
resetting CMOS on page 83.)

2.  Remove expansion boards.

3. Replace the system board.

005-Real-Time Clock Power Loss Invalid time or date in configuration memory. Reset the date and time under Control Panel
(Computer Setup can also be used). If the
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Control panel message

Description

Recommended action

RTC (real-time clock) battery may need to
be replaced.

problem persists, replace the RTC battery. See
the Removal and Replacement section for
instructions on installing a new battery.

008—-Microcode Patch Error

Processor is not supported by the BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.

009-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1.  Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the computer, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

00A-Product Information Not Valid

The product information programmed into the
system board is missing or invalid.

Use Computer Setup to update this information.

00B-MEBx Module did not checksum correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.  If the error persists, replace the system
board.

00C-PMM Deallocation Error during MEBx
Cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

00D-Setup Error during MEBx Execution

MEBX selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.
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Control panel message

Description

Recommended action

00E-Inventory Error during MEBx Execution

BIOS information passed to the MEBx resulted
in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

00F-Interface Error during MEBx Execution

MEBx operation experienced a hardware error
during communication with the ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

100-Front Audio Not Connected

Front audio cable has been detached or
unseated from system board.

Reconnect or replace front audio cable.

2E1-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

The system memory size is different from the
last startup. The most common reason is the
removal of memory from the system board.
Press the F1 key to save the memory changes.
If this message persists, verify that the
memory modules are installed correctly.

2E2-Memory Error

Memory module configuration failed during
boot up.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3.  Remove and replace the identified faulty
memory module(s).

4. |If the error persists after replacing
memory modules, replace the system
board.

2E3-Incompatible Memory Module in Memory
Socket(s) X, X, ...

A memory module in memory socket identified
in the error message is missing critical SPD

information, or is incompatible with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace with a supported module.

2E4-DIMM Configuration Warning

The current memory configuration is not
optimized.

Rearrange the DIMMs so that each channel has
the same amount of memory.

2E5-ECC Memory Module Detected on
Unsupported Platform

Recently added memory module(s) support ECC
memory error correction.

1.  If additional memory was recently added,
remove it to see if the problem remains.

2. Check product documentation for
memory support information.

2E6—-Memory Not Configured Correctly for
Proper MEBx Execution

DIMM1 is not installed.

Make sure there is a memory module in the
DIMM1 socket and that it is properly seated.

300—Configuration Change Warning

The storage device configuration will be
updated as shown.

Not applicable

301-Hard Disk 1: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)
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Control panel message

Description

Recommended action

Back up contents and replace hard drive.

302-Hard Disk 2: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

Back up contents and replace hard drive.

309 - 30C: Hard Disk 3—6: SMART Hard Drive
Detects Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

3.

Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

Back up contents and replace hard drive.

3F0-Boot Device Not Found

Boot device not found.

Insert boot device or load operating system.

3F1-Hard Disk 1 Error Hard disk 1 error. 1.  Check and/or replace cables.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 83.)
3.  Replace the hard disk drive.
3F2-Hard Disk 2 Error Hard disk 2 error. 1. Check and/or replace cables.
2. Clear CMOS. (See Password security and
resetting CMOS on page 83.)
3.  Replace the hard disk drive.
400-Serial Port A Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 83.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
401-Serial Port B Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 83.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
402-Serial Port C Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 83.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
403-Serial Port D Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2. Clear CMOS. (See Password security and

resetting CMOS on page 83.)

POST numeric codes and text messages

79


http://www.hp.com/support
http://www.hp.com/support

Control panel message

Description

Recommended action

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

419-0ut of Memory Space for Option ROMs

Recently added PCl expansion card contains an
option ROM too large to download during POST.

A If aPCl expansion card was recently
added, remove it to see if the problem
remains.

41A-Front USB1/USB2 Not Connected

Front USB cable has been detached or unseated
from system board.

Reconnect or replace front USB cable.

41B-Device in PCl Express Slot Failed To
Initialize

There is an incompatibility or problem with a
PCle device and the system or PCle link could
not be configured to a valid bus width or speed.

Try rebooting the system. If the error reoccurs,
the device may not work with this system

43A-USB Type-C I12C Not Connected

Cable is required between I2C on card and USB-
Con the system board.

Install cable between I2C on card and USB-C on
the system board.

43B-More Than One USB type-C Cards Are
Installed

More than one USB type-C card is installed.

Remove USB type-C card so only one is
installed.

500-BIOS Recovery

A system BIOS recovery has occurred.

Not applicable.

70x-Wireless Mode Not Supported

The system has detected a wireless module
installed in the system that is not supported
and has been disabled.

Replace with a supported module.

800-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.

801-Keyboard or System Unit Error

Keyboard failure.

1.  Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

900-CPU Fan Not Detected

CPU fan is not connected or may have
malfunctioned.

1.  Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

901-Chassis, Rear Chassis, or Front Chassis Fan
not Detected

Chassis, rear chassis, or front chassis fan is not
connected or may have malfunctioned.

1.  Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

903-Computer Cover Has Been Removed Since
Last System Startup

N/A

904-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the SATA 0
and SATA 1 ports should be used for hard drives
before other ports.

Ensure SATA connectors are used in ascending
order. For one device, use SATA 0. For two
devices, use SATA 0 and SATA 1. For three
devices, use SATA 0, SATA 1, and SATA 2.
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Control panel message

Description

Recommended action

90B-Fan Failure

The system has detected that a cooling fan is
not operating correctly.

1. Reseat fan.
2. Reseat fan cable.

3. Replace fan.

90D-System Temperature

Thermal shutdown occurred. The system BIOS
has detected your machine was previously shut
down to avoid overheating. Overheating may
occur if the cooling vents are blocked or the
operating temperature exceeds the system
specifications. The machine should return to

normal operation once the situation is resolved.

Make sure system has proper airflow.

90E-Power Supply Fan Not detected

Power supply fan is not connected or may have
malfunctioned.

1. Reseat power supply fan.
2. Reseat fan cable.

3. Replace power supply fan.

910-Filter Warning

Airflow filter is dirty.

Replace the airflow filter.

Interpreting system validation diagnostic front panel LEDs and

audible codes

During the system validation phase that occurs at system startup, the BIOS validates the functionality of the

following subsystems and conditions:

e  ACadapter

e  System board power
e  Processor failure

e  BIOS corruption

e  Memory failure

e  Graphics failure

e  System board failure

° BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where

applicable) are used to identify the error. These patterns will make up a two part code:

e  Major —the category of the error

e  Minor—the specific error within the category

B NOTE: Single beep/blink codes are not used.

Number of long beeps/blinks Error category
1 Not used

2 BIOS

3 Hardware

Interpreting system validation diagnostic front panel LEDs and audible codes
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Number of long beeps/blinks Error category

4 Thermal

5 System board

Patterns of blink/beep codes are determined by using the following parameters:

e 1 second pause occurs after the last major blink.

° 2 second pause occurs after the last minor blink.

e  Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

e  Blink error code sequences continue until the computer is unplugged or the power button is pressed.

[%’/r NOTE: Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent the
minor error category (short blinks). For example, ‘3.5’ indicates 3 long red blinks and 5 short white blinks to
communicate the processor is not detected.

Category Major/minor code Description

BIOS 2.2 The main area (DXE) of BIOS has become corrupted and there is no recovery
binary image available.

2.3 The embedded controller policy requires the user to enter a key sequence.
2.4 The embedded controller is checking or recovering the boot block.
Hardware 3.2 The embedded controller has timed out waiting for BIOS to return from

memory initialization.

3.3 The embedded controller has timed out waiting for BIOS to return from
graphics initialization.

3.4 The system board displays a power failure (crowbar).*
3.5 The processor is not detected.*
3.6 The processor does not support an enabled feature.
Thermal 4.2 A processor over temperature condition has been detected.*
4.3 An ambient temperature over temperature condition has been detected.
4.4 An MXM over temperature condition has been detected.
System board 5.2 The embedded controller cannot find valid firmware.
5.3 The embedded controller has timed out waiting for the BIOS.
5.4 The embedded controller has timed out waiting for BIOS to return from

system board initialization.

5.5 The embedded controller rebooted the system after a possible lockup
condition had been detected through the use of a System Health Timer,
Automated System Recovery Timer, or other mechanism.

* Indicates hardware triggered event; all other events are controlled by the BIOS.
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Password security and resetting CMOS

This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: administrator password and power-on password. When you establish only an administrator
password, any user can access all the information on the computer except Computer Setup. When you
establish only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the administrator password will
give you access to Computer Setup.

When both passwords are set, the administrator password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget one or both passwords, you can clear all passwords by powering off the system, opening the
cover, temporarily removing the CLR_PSWD jumper, and booting once. This will erase the administrator and
power-on passwords. You must restore the jumper to create new passwords.

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS jumper resets CMOS but does not clear the power-on and setup passwords.

A CAUTION: Resetting the CMOS with power removed will reset the BIOS settings to factory defaults. It may

be useful to back up the BIOS settings or save them as custom defaults before resetting them in case they are
needed later. Back up can be performed in Computer Setup or using the BiosConfigUtility tool available from
www.hp.com. See Computer Setup (F10) Utility on page 40 for information on backing up the BIOS settings.

Resetting CMOS resets BIOS settings to default, but does not clear the passwords or affect any of the other
Security settings. On Intel systems with advanced manageability features, resetting CMOS will also partially
unprovision AMT.

A CAUTION: Stringent security is a mode where there is no physical bypass of the password function. If

enabled, removing the password jumper will be ignored. To enable this mode, change the security setting
Clear Password Jumper in Password Policies to Ignore.

If you lose or forget the password when in stringent security mode, the system can only be reset by System
Management Command. This is a way for HP Service and Support to provide a secure method to access the

BIOS and command a password reset for a specifically identified unit under the direction of the owner. This

scenario may not be covered under warranty.

To prevent needing a customer service event to restore access to the system, record your configured
administrator and power-on passwords in a safe place away from your computer.

[:;’/f’ NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that

configuration changes have occurred. Use Computer Setup to reset any special system setups along with the
date and time.

A CAUTION: Itisimportant to back up the computer CMOS settings before resetting them in case they are

needed later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 40 for
information on backing up the CMOS settings.
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Resetting CMOS and/or the password jumper
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This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: administrator password and power-on password. When you establish only an administrator
password, any user can access all the information on the computer except Computer Setup. When you
establish only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the administrator password will
give you access to Computer Setup.

When both passwords are set, the administrator password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget one or both passwords, you can clear all passwords by powering off the system, opening the
cover, temporarily removing the CMOS/PSWD jumper, and booting once. This will erase the administrator and
power-on passwords. You must restore the jumper to create new passwords.

A CAUTION: Resetting the CMOS with power removed will reset the BIOS settings to factory defaults. It may

be useful to back up the BIOS settings or save them as custom defaults before resetting them in case they are
needed later. Back up can be performed in Computer Setup or using the BiosConfigUtility tool available from
www.hp.com. See Computer Setup (F10) Utility on page 40 for information on backing up the BIOS settings.

Resetting CMOS resets BIOS settings to default, but does not clear the passwords or affect any of the other
Security settings. On Intel systems with advanced manageability features, resetting CMOS will also partially
unprovision AMT.

A CAUTION: Stringent security is a mode where there is no physical bypass of the password function. If

enabled, removing the password jumper will be ignored. To enable this mode, change the security setting
Clear Password Jumper in Password Policies to Ignore.

If you lose or forget the password when in stringent security mode, the system can only be reset by System
Management Command. This is a way for HP Service and Support to provide a secure method to access the

BIOS and command a password reset for a specifically identified unit under the direction of the owner. This

scenario may not be covered under warranty.

To prevent needing a customer service event to restore access to the system, record your configured
administrator and power-on passwords in a safe place away from your computer.

[%’/]" NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that

configuration changes have occurred. Use Computer Setup to reset any special system setups along with the
date and time.

To clear CMOS, disable the power-on or administrator password features, or to clear the power-on or
administrator passwords, complete the following steps:
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Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

With the power cord disconnected, press the power button again to drain the system of any residual
power.

A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to

disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

A CAUTION: When the computer is plugged in, the power supply always has voltage applied to the

3.
4

:
[%

o N o owu

10.
11.
12.
13.

system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

Remove the access panel.

Locate the header and jumper labeled CMOS/PSWD.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the system board components image at
System board callouts on page 38.

Remove the jumper from pins 1 and 2.
Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.
Replace the access panel and reconnect the external equipment.

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

Shut down the computer, unplug the power, and disconnect the external equipment.
Remove the access panel.

Place the jumper on pins 1 and 2.

Replace the access panel.

Reconnect the external equipment and plug in the computer.

Changing a Setup or Power-0n password

To change the power-on or setup password, complete the following steps:

1.

Turn on or restart the computer.

To change the Setup password, go to step 2.

To change the Power-on password, go to step 3.

To change the Setup password, as soon as the computer turns on:

- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.
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3.  When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/new password/new password

[%f NOTE: Type the new password carefully since the characters do not appear on the screen.

4. Press Enter.

The new password will take effect the next time the computer is restarted.

Deleting a Setup or Power-0On password

To delete the power-on or setup password, complete the following steps:
1. Turnon or restart the computer.
To delete the Setup password, go to step 2.
To delete the Power-on password, go to step 3.
2. Todelete the Setup password, as soon as the computer turns on:
- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.

3.  When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/

4. Press Enter.
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9 Using HP PC Hardware Diagnostics

Using HP PC Hardware Diagnostics Windows

HP PC Hardware Diagnostics Windows is a Windows-based utility that allows you to run diagnostic tests to
determine whether the computer hardware is functioning properly. The tool runs within the Windows
operating system in order to diagnose hardware failures.

If HP PC Hardware Diagnostics Windows is not installed on your computer, first you must download and install
it. To download HP PC Hardware Diagnostics Windows, see Downloading HP PC Hardware Diagnostics
Windows on page 87.

After HP PC Hardware Diagnostics Windows is installed, follow these steps to access it from HP Help and
Support or HP Support Assistant.

1.  Toaccess HP PC Hardware Diagnostics Windows from HP Help and Support:
a. Select the Start button, and then select HP Help and Support.

b. Right-click HP PC Hardware Diagnostics Windows, select More, and then select Run as
administrator.

—or—
To access HP PC Hardware Diagnostics Windows from HP Support Assistant:
a. Type support inthe taskbar search box, and then select the HP Support Assistant app.
—or-
Select the question mark icon in the taskbar.
b. Select Troubleshooting and fixes.
¢. Select Diagnostics, and then select HP PC Hardware Diagnostics Windows.

2. When the tool opens, select the type of diagnostic test you want to run, and then follow the on-screen
instructions.

@”f NOTE: If you need to stop a diagnostic test at any time, select Cancel.

3.  When HP PC Hardware Diagnostics Windows detects a failure that requires hardware replacement, a 24-
digit Failure ID code is generated. For assistance in correcting the problem, contact support, and then
provide the Failure ID code.

Downloading HP PC Hardware Diagnostics Windows
e  The HP PC Hardware Diagnostics Windows download instructions are provided in English only.

e  Youmust use a Windows computer to download this tool because only .exe files are provided.
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Downloading the latest HP PC Hardware Diagnostics Windows version

To download HP PC Hardware Diagnostics Windows, follow these steps:

1.  Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics section, select Download, and then select the installation location:
To run the tool on your computer, download it to the computer desktop.
—or-
To run the tool from a USB flash drive, download it to a USB flash drive.

3. Select Run.

Downloading HP Hardware Diagnostics Windows by product name or number (select products
only)

9

B NOTE: For some products, it may be necessary to download the software to a USB flash drive by using the
product name or number.

To download HP PC Hardware Diagnostics Windows by product name or number (select products only), follow
these steps:

1. Go to http://www.hp.com/support.

2. Select Get software and drivers, and then enter the product name or number.

3. Inthe HP PC Hardware Diagnostics section, select Download, and then select the installation location:
To run the tool on your computer, download it to the computer desktop.
—or-
To run the tool from a USB flash drive, download it to a USB flash drive.

4. Select Run.

Installing HP PC Hardware Diagnostics Windows

To install HP PC Hardware Diagnostics Windows, follow these steps:

A Navigate to the folder on your computer or the flash drive where the .exe file was downloaded, double-
click the .exe file, and then follow the on-screen instructions.

Using HP PC Hardware Diagnostics UEFI

HP PC Hardware Diagnostics UEFI (Unified Extensible Firmware Interface) allows you to run diagnostic tests to
determine whether the computer hardware is functioning properly. The tool runs outside the operating
system so that it can isolate hardware failures from issues that are caused by the operating system or other
software components.

If your PC will not boot into Windows, you can use HP PC Hardware Diagnostics UEFI to diagnose hardware
issues.

When HP PC Hardware Diagnostics UEFI detects a failure that requires hardware replacement, a 24-digit
Failure ID code is generated. For assistance in correcting the problem, contact support, and provide the Failure
ID code.

[%’/r NOTE: To start diagnostics on a convertible computer, your computer must be in notebook mode, and you
must use the attached keyboard.
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[% NOTE: If you need to stop a diagnostic test, press esc.

Starting HP PC Hardware Diagnostics UEFI

To start HP PC Hardware Diagnostics UEFI, follow these steps:
1. Turnon or restart the computer, and quickly press esc.
2. Pressf2.
The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB flash drive

Ej%? NOTE: To download the HP PC Hardware Diagnostics UEFI tool to a USB flash drive, see
Downloading the latest HP PC Hardware Diagnostics UEFI version on page 89.

b. Harddrive
c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions.

Downloading HP PC Hardware Diagnostics UEFI to a USB flash drive

Downloading HP PC Hardware Diagnostics UEFI to a USB flash drive can be useful in the following situations:
e  HP PCHardware Diagnostics UEFI is not included in the preinstall image.
e  HP PCHardware Diagnostics UEFI is not included in the HP Tool partition.

e  The hard drive is damaged.

[Z?’”f} NOTE: The HP PCHardware Diagnostics UEFI download instructions are provided in English only, and you
must use a Windows computer to download and create the HP UEFI support environment because only .exe
files are provided.

Downloading the latest HP PC Hardware Diagnostics UEFI version
To download the latest HP PC Hardware Diagnostics UEFI version to a USB flash drive:

1.  Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics UEFI section, select Download UEFI Diagnostics, and then select
Run.

Downloading HP PC Hardware Diagnostics UEFI by product name or number (select products
only)

[Z?’”f} NOTE: For some products, it may be necessary to download the software to a USB flash drive by using the
product name or number.

To download HP PC Hardware Diagnostics UEFI by product name or number (select products only) to a USB
flash drive:

1. Go to http://www.hp.com/support.

2. Enter the product name or number, select your computer, and then select your operating system.

3. Inthe Diagnestics section, follow the on-screen instructions to select and download the specific UEFI
Diagnostics version for your computer.
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Using Remote HP PC Hardware Diagnostics UEFI settings (select
products only)

Remote HP PC Hardware Diagnostics UEFI is a firmware (BIOS) feature that downloads HP PC Hardware
Diagnostics UEFI to your computer. It can then execute the diagnostics on your computer, and it may upload
results to a preconfigured server. For more information on Remote HP PC Hardware Diagnostics UEFI, go to
http://www.hp.com/go/techcenter/pcdiags, and then select Find out more.

Downloading Remote HP PC Hardware Diagnostics UEFI

[%/r NOTE: HP Remote PC Hardware Diagnostics UEFI is also available as a Softpaq that can be downloaded to a
server.

Downloading the latest Remote HP PC Hardware Diagnostics UEFI version
To download the latest Remote HP PC Hardware Diagnostics UEFI version, follow these steps:

1. Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics UEFI section, select Download Remote Diagnostics, and then select
Run.

Downloading Remote HP PC Hardware Diagnostics UEFI by product name or number

[%/r NOTE: For some products, it may be necessary to download the software by using the product name or
number.

To download HP Remote PC Hardware Diagnostics UEFI by product name or number, follow these steps:

1. Go to http://www.hp.com/support.

2. Select Get software and drivers, enter the product name or number, select your computer, and then
select your operating system.

3. Inthe Diagnostics section, follow the on-screen instructions to select and download the Remote UEFI
version for the product.

Customizing Remote HP PC Hardware Diagnostics UEFI settings

Using the Remote HP PC Hardware Diagnostics setting in Computer Setup (BIOS), you can perform the
following customizations:

e Setaschedule for running diagnostics unattended. You can also start diagnostics immediately in
interactive mode by selecting Execute Remote HP PC Hardware Diagnostics.

e Set thelocation for downloading the diagnostic tools. This feature provides access to the tools from the
HP website or from a server that has been preconfigured for use. Your computer does not require the
traditional local storage (such as a disk drive or USB flash drive) to run remote diagnostics.

e Setalocation for storing the test results. You can also set the user name and password settings used for
uploads.

e  Display status information about the diagnostics run previously.
To customize Remote HP PC Hardware Diagnostics UEFI settings, follow these steps:
1. Turnon or restart the computer, and when the HP logo appears, press f10 to enter Computer Setup.

2. Select Advanced, and then select Settings.
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3. Make your customization selections.
4. Select Main, and then Save Changes and Exit to save your settings.

Your changes take effect when the computer restarts.
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10 Backing up, restoring, and recovering

This chapter provides information about the following processes, which are standard procedure for most
products:

Backing up your personal information—You can use Windows tools to back up your personal
information (see Using Windows tools on page 92).

Creating a restore point—You can use Windows tools to create a restore point (see Using Windows
tools on page 92).
Creating recovery media (select products only)—You can use HP Recovery Manager or HP Cloud

Recovery Download Tool (select products only) to create recovery media (see Creating HP Recovery
media (select products only) on page 92).

Restoring and recovery—Windows offers several options for restoring from backup, refreshing the
computer, and resetting the computer to its original state (see Using Windows tools on page 92).

Removing the Recovery Partition—To remove the Recovery partition to reclaim hard drive space
(select products only), select the Remove Recovery Partition option of HP Recovery Manager. For more
information, see Removing the HP Recovery partition (select products only) on page 96.

Using Windows tools

@” IMPORTANT: Windows is the only option that allows you to back up your personal information. Schedule
regular backups to avoid information loss.

You can use Windows tools to back up personal information and create system restore points and recovery
media, allowing you to restore from backup, refresh the computer, and reset the computer to its original
state.

r.%’ NOTE: If computer storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get Help app.

A Select the Start button, and then select the Get Help app.

[%9 NOTE: You must be connected to the Internet to access the Get Help app.

Creating HP Recovery media (select products only)

After you have successfully set up the computer, use HP Recovery Manager to create a backup of the HP
Recovery partition on the computer. This backup is called HP Recovery media. In cases where the hard drive is
corrupted or has been replaced, the HP Recovery media can be used to reinstall the original operating system.

To check for the presence of the Recovery partition in addition to the Windows partition, right-click the Start
button, select File Explorer, and then select This PC.

[%’/]’9 NOTE: If your computer does not list the Recovery partition in addition to the Windows partition, contact
support to obtain recovery discs. Go to http://www.hp.com/support, select your country or region, and then
follow the on-screen instructions.
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On select products, you can use the HP Cloud Recovery Download Tool to create HP Recovery media on a
bootable USB flash drive. For more information, see Using the HP Cloud Recovery Download Tool to create
recovery media on page 94.

Using HP Recovery Manager to create recovery media

Ej?)y NOTE: If you cannot create recovery media yourself, contact support to obtain recovery discs. Go to
http://www.hp.com/support, select your country or region, and then follow the on-screen instructions.

Before you begin
Before you begin, note the following:

e  Only one set of recovery media can be created. Handle these recovery tools carefully, and keep themin a
safe place.

e  HP Recovery Manager examines the computer and determines the required media storage capacity.

e To create recovery media, use one of the following options:

[%”f NOTE: If the computer does not have a recovery partition, HP Recovery Manager displays the Windows
Create a Recovery Drive feature. Follow the on-screen instructions to create a recovery image on a blank
USB flash drive or hard drive.

—  If your computer has an optical drive with DVD writer capability, be sure to use only high-quality
blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable discs such as CDRW,
DVD+RW, double-layer DVD+RW, or BD-RE (rewritable Blu-ray) discs, which are not compatible
with HP Recovery Manager software.

—  If your computer does not include an integrated optical drive with DVD writer capability, you can
use an external optical drive (purchased separately) to create recovery discs, as described above. If
an external optical drive is used, you must connect it directly to a USB port on the computer. It
cannot be connected to a USB port on an external device, such as a USB hub.

—  To create a recovery flash drive, use a high-quality blank USB flash drive.
° Be sure that the computer is connected to AC power before you begin creating the recovery media.
e  The creation process can take an hour or more. Do not interrupt this process.

e If necessary, you can exit the program before you have finished creating all of the recovery media. HP
Recovery Manager will finish the current DVD or flash drive. The next time you start HP Recovery
Manager, you will be prompted to continue.

Creating the recovery media

To create HP Recovery media using HP Recovery Manager:

[Q" IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps.

1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.
2. Select Create recovery media, and then follow the on-screen instructions.

If you need to recover the system, see Recovering using HP Recovery Manager on page 94.
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Using the HP Cloud Recovery Download Tool to create recovery media

To create HP Recovery media using the HP Cloud Recovery Download Tool:

1. Go to http://www.hp.com/support.

2. Select Software and Drivers, and then follow the on-screen instructions.

Restoring and recovery

Restoring and recovery can be performed using one or more of the following options: Windows tools, HP
Recovery Manager, or the HP Recovery partition.

[Q IMPORTANT: Not all methods are available on all products.

Restoring, resetting, and refreshing using Windows tools

Windows offers several options for restoring, resetting, and refreshing the computer. For details, see Using
Windows tools on page 92.

Restoring using HP Recovery Manager and the HP Recovery partition

You can use HP Recovery Manager and the HP Recovery partition (select products only) to restore the
computer to the original factory state:

e  Resolving problems with preinstalled applications or drivers—To correct a problem with a
preinstalled application or driver:

1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.
2. Select Reinstall drivers and/or applications, and then follow the on-screen instructions.

e  Using System Recovery—To recover the Windows partition to original factory content, select the
System Recovery option from the HP Recovery partition (select products only) or use the HP Recovery
media. For more information, see Recovering using HP Recovery Manager on page 94. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 92.

e  Using Factory Reset (select products only)—Restores the computer to its original factory state by
deleting all information from the hard drive and recreating the partitions and then reinstalling the
operating system and the software that was installed at the factory (select products only). To use the
Factory Reset option, you must use HP Recovery media. If you have not already created recovery media,
see Creating HP Recovery media (select products only) on page 92.

Ej?’y NOTE: If you have replaced the hard drive in the computer, you can use the Factory Reset option to
install the operating system and the software that was installed at the factory.

Recovering using HP Recovery Manager

You can use HP Recovery Manager software to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only).

If you have not already created HP Recovery media, see Creating HP Recovery media (select products only)
on page 92.

[Q’ IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data that you want to retain. See Using Windows tools on page 92.
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IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct computer
issues.

[i;’/r NOTE: When you start the recovery process, only the options available for your computer are displayed.

Before you begin, note the following:

e  HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.

e  |f the computer hard drive fails, HP Recovery media must be used. This media is created using HP
Recovery Manager. See Creating HP Recovery media (select products only) on page 92.

e |f your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, contact support to obtain recovery media. Go to http://www.hp.com/support, select your country
or region, and then follow the on-screen instructions.

Recovering using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without recovery discs or a recovery USB
flash drive. This type of recovery can be used only if the hard drive is still working.

The HP Recovery partition (select products only) allows System Recovery only.

To start HP Recovery Manager from the HP Recovery partition:

@ IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps (select products only).

1. Type recovery inthe taskbar search box, select HP Recovery Manager, and then select Windows
Recovery Environment.

_or—
For computers or tablets with keyboards attached:
A Press f11 while the computer boots, or press and hold f11 as you press the power button.
For tablets without keyboards:
A Turnon orrestart the tablet, quickly hold down the volume up button, and then select f11.
2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

[%”f NOTE: If your computer does not automatically restart in HP Recovery Manager, change the computer
boot order, and then follow the on-screen instructions. See Changing the computer boot order
on page 96.

Recovering using HP Recovery media

If your computer does not have an HP Recovery partition or if the hard drive is not working properly, you can
use HP Recovery media to recover the original operating system and software programs that were installed at
the factory.

A Insert the HP Recovery media, and then restart the computer.
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[%f NOTE: If your computer does not automatically restart in HP Recovery Manager, change the computer
boot order, and then follow the on-screen instructions. See Changing the computer boot order
on page 96.

Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order. This is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive, depending on the location of your HP Recovery media.

To change the boot order:

M” IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps.

1. Insert the HP Recovery media.
2. Access the system Startup menu.
For computers or tablets with keyboards attached:
A Turnon orrestart the computer or tablet, quickly press esc, and then press f9 for boot options.
For tablets without keyboards:
A Turnon orrestart the tablet, quickly hold down the volume up button, and then select £9.
_or-
Turn on or restart the tablet, quickly hold down the volume down button, and then select 9.
3. Select the optical drive or USB flash drive from which you want to boot, and then follow the on-screen

instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition (select products only) to free
up hard drive space.

M” IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP Recovery media. Before removing the Recovery partition, create HP Recovery media. See
Creating HP Recovery media (select products only) on page 92.

Follow these steps to remove the HP Recovery partition:
1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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A Statement of memory volatility

The purpose of this chapter is to provide general information regarding nonvolatile memory in HP Business
computers. This chapter also provides general instructions for restoring nonvolatile memory that can contain
personal data after the system has been powered off and the hard drive has been removed.

HP Business computer products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped
from HP, assuming that no subsequent modifications have been made to the system and assuming that no
applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business computer system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. Use the steps below to remove personal data from the computer, including the
nonvolatile memory found in Intel-based and AMD-based system boards.

E?'”f NOTE: If your tablet has a keyboard base, connect to the keyboard base before beginning steps in this
chapter.

Current BIOS steps

1. Follow steps (a) through (1) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Ej?"” NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

b. Select Main, select Apply Factory Defaults and Exit, and then select Yes to load defaults.
The computer will reboot.

€.  During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

[17? NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

d. Select the Security menu, select Restore Security Settings to Factory Defaults, and then select
Yes to restore security level defaults.

The computer will reboot.

e. During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

[17? NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

f.  If anasset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select Asset Tracking Number. Clear the tag, and then make the
selection to return to the prior menu.
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If a DriveLock password is set, select the Security menu, and scroll down to Hard Drive Utilities
under the Utilities menu. Select Hard Drive Utilities, select DriveLock, then uncheck the checkbox
for DriveLock password on restart. Select OK to proceed.

Select the Main menu, and then select Reset BIOS Security to factory default. Click Yes at the
warning message.

The computer will reboot.

During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

ﬁ/{’ NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

Select the Main menu, select Apply Factory Defaults and Exit, select Yes to save changes and exit,
and then select Shutdown.

Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint reader,
one or two prompts will appear—one to clear the TPM and the other to Reset Fingerprint Sensor;
press or tap F1 to accept or F2 to reject.

Remove all power and system batteries for at least 24 hours.

Complete one of the following:

Remove and retain the storage drive.

Clear the drive contents by using a third party utility designed to erase data from an SSD.

Clear the contents of the drive by using the following BIOS Setup Secure Erase command option
steps:

22 IMPORTANT: I you clear data using Secure Erase, it cannot be recovered.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Select the Security menu and scroll down to the Utilities menu.
Select Hard Drive Utilities.

Under Utilities, select Secure Erase, select the hard drive storing the data you want to clear, and
then follow the on-screen instructions to continue.
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Nonvolatile memory usage

Does this Does this
memory memory
store retain data What is the
Nonvolatile customer whenpower purpose of this How is data input into this How is this memory
Memory Type Amount (Size) data? isremoved? memory? memory? write-protected?
HP Sure Start flash 8 MBytes No Yes Provides Data cannot be written to this  This memory is protected
(select models protected device via the host processor. by the HP Sure Start
only) backup of The content is managed Embedded Controller.
critical System  solely by the HP Sure Start
BIOS code, EC Embedded Controller.
firmware, and
critical
computer
configuration
data for select
platforms that
support HP
Sure Start.
For more
information,
see Using HP
Sure Start
(select models
only)
on page 102.
Real Time Clock 256 Bytes No Yes Stores system RTC battery backed-up CMOS  This memory is not write-
(RTC) battery date and time is programmed using the protected.
backed-up CMOS and noncritical  Computer Setup (BIOS), or
configuration data. changing the Microsoft
memory Windows date & time.
Controller (NIC) 64 KBytes (not  No Yes Stores NIC NIC EEPROM is programmed A utility is required to
EEPROM customer configuration using a utility from the NIC write data to this memory
accessible) and NIC vendor that can be run from and is available from the
firmware. DOS. NIC vendor. Writing data
to this ROMin an
inappropriate manner will
render the NIC non-
functional.
DIMM Serial 256 Bytes per No Yes Stores memory  DIMM SPD is programmed by ~ Data cannot be written to
Presence Detect memory module the memory vendor. this memory when the
(SPD) module, 128 information. module is installed in a
configuration data Bytes computer. The specific
programmable write-protection method
(not customer varies by memory vendor.
accessible)
System BIOS 9 MBytes Yes Yes Stores system System BIOS code is NOTE: Writing data to
BIOS code and programmed at the factory. this ROM in an
computer Code is updated when the inappropriate manner can

configuration
data.

system BIOS is updated.
Configuration data and
settings are input using the
Computer Setup (BIOS) or a
custom utility.

render the computer non-
functional.

A utility is required for
writing data to this
memory and is available
on the HP website; go to
http://www.hp.com
support. Select Find your
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Does this Does this
memory memory
store retain data What is the
Nonvolatile customer when power purpose of this How is data input into this How is this memory
Memory Type Amount (Size) data? isremoved? memory? memory? write-protected?
product, and then follow
the on-screen
instructions.
Intel Management 1.5 MBytesor7  Yes Yes Stores Management Engine Codeis  The Intel chipset is
Engine Firmware MBytes Management programmed at the factory. configured to enforce
(present only in Engine Code, Code is updated via Intel hardware protection to
select Elite or Z Settings, secure firmware update block all direct read/write
models. For more Provisioning utility. Unique Provisioning access to this area. An
information, go to Dataand iAMT  Data can be entered at the Intel utility is required for
http://www.hp.com/ third-party data factory or by an updating the firmware.
support. Select store. administrator using the Only firmware updates
Find your Management Engine (MEBXx) digitally signed by Intel
product, and then setup utility. The third party can be applied using this
follow the on- data store contents can be utility.
screen populated by a remote
instructions.) management console or local
applications that have been
registered by an
administrator to have access
to the space.
Bluetooth flash 2 Mbit No Yes Stores Bluetooth flash is A utility is required for
(select products Bluetooth programmed at the factory. writing data to this
only) configuration Tools for writing data to this  memory and is made
and firmware. memory are not publicly available through newer
available but can be obtained  versions of the driver
from the silicon vendor. whenever the flash
requires an upgrade.
802.11 WLAN 4 Kbit to 8 Kbit No Yes Stores 802.11 WLAN EEPROM is A utility is required for
EEPROM configuration programmed at the factory. writing data to this
and calibration  Tools for writing data to this ~ memory and is typically
data. memory are not made public. not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.
Webcam (select 64 Kbit No Yes Stores webcam  Webcam memory is A utility is required for
products only) configuration programmed using a utility writing data to this
and firmware. from the device memory and is typically
manufacturer that canberun  not made available to the
from Windows. public unless a firmware
upgrade is necessary to
address a unique issue.
Fingerprint reader 512 KByte flash  Yes Yes Stores Fingerprint reader memoryis  Only a digitally signed
(select products fingerprint programmed by user application can make the
only) templates. enrollment in HP call to write to the flash.

ProtectTools Security
Manager.
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Questions and answers

1. How can the BIOS settings be restored (returned to factory settings)?

Mf’ IMPORTANT: Restore defaults does not securely erase any data on your hard drive. See question and
answer 6 for steps to securely erase data.

Restore defaults does not reset the Custom Secure Boot keys. See question and answer 7 for
information about resetting the keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select Main, and then select Apply Factory Defaults and Exit.

¢. Follow the on-screen instructions.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.
2. Whatis a UEFI BIOS, and how is it different from a legacy BI10S?

The Unified Extensible Firmware Interface (UEFI) BIOS is an industry-standard software interface
between the platform firmware and an operating system (0S). It is a replacement for the older BIOS
architecture, but supports much of the legacy BIOS functionality.

Like the legacy BIOS, the UEFI BIOS provides an interface to display the system information and
configuration settings and to change the configuration of your computer before an 0S is loaded. BIOS
provides a secure run-time environment that supports a Graphic User Interface (GUI). In this
environment, you can use either a pointing device (Touchscreen, TouchPad, pointing stick, or USB
mouse) or the keyboard to navigate and make menu and configuration selections. The UEFI BIOS also
contains basic system diagnostics.

The UEFI BIOS provides functionality beyond that of the legacy BIOS. In addition, the UEFI BIOS works to
initialize the computer’s hardware before loading and executing the 0S; the run-time environment
allows the loading and execution of software programs from storage devices to provide more
functionality, such as advanced hardware diagnostics (with the ability to display more detailed system
information) and advanced firmware management and recovery software.

HP has provided options in Computer Setup (BIOS) to allow you to run in legacy BIOS, if required by the
operating system. Examples of this requirement would be if you upgrade or downgrade the 0S.

3. Where does the UEFI BIOS reside?
The UEFI BIOS resides on a flash memory chip. A utility is required to write to the chip.

4. Whatkind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?

The DIMM SPD memory contains information about the memory module, such as size, serial number,
data width, speed/timing, voltage, and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a computer. Third-party tools do exist that can write to the EEPROM when the memory
module is not installed in a computer. Various third-party tools are available to read SPD memory.

5. Whatis meant by “Restore the nonvolatile memory found in Intel-based system boards”?

This message relates to clearing the Real Time Clock (RTC) CMOS memory that contains computer
configuration data.

6. How can the BIOS security be reset to factory defaults and data erased?
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iZZ IMPORTANT: Resetting will result in the loss of information.

These steps will not reset Custom Secure Boot Keys. See question and answer 7 for information about
resetting the keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select Main, and then select Reset Security to Factory Defaults.

¢. Follow the on-screen instructions.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.
7. How can the Custom Secure Boot Keys be reset?

Secure Boot is a feature to ensure that only authenticated code can start on a platform. If you enabled
Secure Boot and created Custom Secure Boot Keys, simply disabling Secure Boot will not clear the keys.
You must also select to clear the Custom Secure Boot Keys. Use the same Secure Boot access procedure
you used to create the Custom Secure Boot Keys, but make the selection to clear or delete all Secure
Boot Keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select the Security menu, select Secure Boot Configuration, and then follow the on-screen
instructions.

¢. Atthe Secure Boot Configuration window, select Secure Boot, select Clear Secure Boot Keys, and
then follow the on-screen instructions to continue.

Using HP Sure Start (select models only)

Select computer models are configured with HP Sure Start, a technology that continuously monitors your
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
restores the BIOS to its previously safe state, without user intervention. Those select computer models ship
with HP Sure Start configured and enabled. HP Sure Start is configured and already enabled so that most
users can use the HP Sure Start default configuration. The default configuration can be customized by
advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support. Select Find your
product, and then follow the on-screen instructions.
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B Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature on
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal switches
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord must be
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed uponiit or
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits
from the product.

A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in
any manner, replace it immediately.

Japanese power cord requirements

For use in Japan, use only the power cord received with this product.

A CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1.  The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3.  Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must be a two-pole
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C Specifications

u.s. Metric
Chassis
Height 3.74in 95 mm
Width 10.63in 270 mm
Depth 11.65in 296 mm
Approximate Weight 9.23 b 4.2 kg
Temperature Range
Operating 32°to 104°F 0°to 40°C
Nonoperating -22°to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%
Nonoperating (38.7°C max wet bulb) 5-95% 5-95%
Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
Nonoperating 30,000 ft 9144 m
Power Supply

Output 180w

Efficiency Up to 85%

Operating Voltage Range 90-264 VAC

Rated Voltage Range’ 100-240 VAC

Rated Line Frequency 50-60 Hz

Operating Line Frequency 47-63 Hz

1

This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements for use
in the countries of the European Union. The active power factor corrected power supply also has the added benefit of not requiring an

input voltage range select switch.
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